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Introduction

Welcome

Welcome to Homeventory - The developers of Homeventory are experienced business
systems professionals who know the features that heavy-duty, professional business
applications must have. You'll find those features in Homeventory.

Back in 1990 | developed the first version of Homeventory mostly to learn about programming
the PC and using dBase. Many different programming languages were utilized including
Quicksilver and Clipper. In 1993 | became a member of the Association of Shareware
Professionals (ASP) and have met a number of shareware authors who have assisted me
over the years. This program is being released as freeware just for registering (no cost) as
my way to thank the shareware community and the ASP.

Who Should Use Homeventory?

Homeventory has been designed for anyone wishing to maintain accurate records about
there possessions, keep track of medical records or maintain a recipe database. The
following are included:

Comprehensive household inventory/asset management system
Vehicle management system

Recipe/cook book database

Shopping coupons database

Book database

CD and other media database

Medical Records database

Personal accounts database

People (names/addresses) database

Comprehensive report writer/generator. You can modify all of our standard reports or
create reports to your own personal needs.
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Although you don’t have to be a computer expert to use Homeventory, you should be familiar
with the following:

The Microsoft Windows/98 operating environment and conventions.

Use of a mouse
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Documentation Conventions

When you see this symbol we will explain a caution topic

Caution

o

Important Notes

=]

Tips and how to’s

General notes

® ©
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User's Guide

This User’s Guide tells you everything you need to know to use Homeventory.

Chapter 1, Getting Started, shows you how to SETUP Homeventory and set it up. Chapter 2
and the subsequent chapters show you how to use Homeventory.

Quick-Start Recommendations

Everybody wants documentation, but few want to read it from cover-to-cover. Everyone
wants to get on with the task at hand.

That's why you'll find a “Quick-Start Recommendation” in the introduction to most chapters.
The Quick-Start Recommendation suggests the quickest way to use the chapter. The Quick-
Start Recommendation points out what you must read and what you can save for later
reference.

4 -
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Homeventory Technical Support

If you need telephone support, call (503) 540-3270. Telephone support hours are from 6:00
p.m. to 10:00 p.m. Monday through Friday Pacific standard time.

You may contact us via the Internet at dean@alpinesoft..com.

When you contact technical support, please provide your Homeventory serial number. You'll
find your Homeventory Serial Number located on the back side of your distribution diskettes.
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Getting Started

This chapter shows you how to SETUP Homeventory on your computer and how to run it.
When you're ready to SETUP Homeventory, you'll need the Homeventory SETUP Disks.

The chapter concludes by pointing out some things that you should know to help you use
Homeventory.

Quick-Start Recommendation  Read this entire chapter. It's chock full of useful information.

Chapter Contents

Installing Homeventory
Before You Begin Installation
Running SETUP

Running Homeventory

Using Homeventory
Homeventory Main Screen
Special Keys, Mouse buttons
Printing

Print Preview
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Installing Homeventory
This section shows you how to install and run Homeventory.

To install Homeventory on your computer you run the program SETUP.EXE on the
Homeventory SETUP compact Disk.

Important You cannot simply copy files from the SETUP Disks to your hard disk. You must
use the SETUP program to decompress and install the Homeventory files in the
Homeventory directories.

Before You Begin Installation

Before you install Homeventory, make sure that your computer meets the minimum
requirements.

Check the Hardware and System Requirements

To run Homeventory, your computer system must meet these requirements:

Any IBM®-compatible computer with a Pentium 350mhz processor or higher.
A mouse.

128 MB RAM.

A hard disk with 400 megabytes of free space.

A CD ROM Dirive.

VGA or higher resolution monitor (At least 1024 x 768).

Microsoft® Windows/98se/NT/2000@/xP (this is a requirement, this version WILL NOT run
under Windows95 or Windows 3.x).

Installed Windows fonts: Arial, Courier New and Times New Roman

8 - Getting Started A guide to using Homeventory



Running Install

Begin the Homeventory installation process by running SETUP.EXE. If you are installing
from a floppy disk drive other than A, adjust the instructions accordingly.

To run SETUP

Insert Homeventory SETUP CD 1 into your CDROM Dirive.

From the File menu of the Program Manager or File Manager, choose Run.
In the Command Line text box, type a:setup and click OK.

Install displays a dialog telling you that it will SETUP Homeventory in the c:\Program
Files\Homeventory directory, or another directory of your choice.

Follow the instructions on the screen.

Install ends.

What SETUP Installs

Homeventory Directories

Install creates a \Mbr directory on your hard disk if it does not already exist with the following

files:
File Description
HOMEV.EXE The main program

A guide to using Homeventory Getting Started - 9



Running Homeventory

To initialize Homeventory

From the Windows Program Manager, start Homeventory by double clicking on the
Homeventory icon:

Selecting the Homeventory window

Double clicking the Homeventory Icon

10 - Getting Started A guide to using Homeventory



Using Homeventory

Main Screen

% Homeventory v4.0
File [ata Reports Registration Info Help

Ads

Homeventory — Main Screen

When you first start the program you will see a screen much like the one illustrated above.

First and foremost you should go to the Systems Options menu and enter information about
your self.

The remainder of this section covers the menu system, the use of the toolbars, and the
navigation toolbar.
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File Menu

The following table briefly describes the File menu options.

Lookup Tables Maintain information in Lookup Tables

Preferences Edit system options

Exit Close and exit out of the program
Data Menu

The following table briefly describes the View menu options.

Home Inventory Add/Change/Delete Inventory Items

Books Add/Change/Delete Books

Vehicle Maintenance Add/Change/Delete Vehicle Records
Recipes Add/Change/Delete Recipes

Coupon Organizer Add/Change/Delete Coupons
Music/CD/Tapes Add/Change/Delete Music/CS/Tape items
Medical Records Add/Change/Delete Medical Records
Accounts Add/Change/Delete Accounts

Address Book Add/Change/Delete Names and Addresses
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Reports Menu

The following table briefly describes the Reports menu options.

Inventory Reports Preview/Prints Inventory Reports

Books Preview/Prints Books Reports

Coupons Preview/Prints Coupons

Vehicle Preview/Prints Vehicle Maintenance Reports
Maintenance

Account Report Preview/Prints Account report

Cook Book Preview/Prints Cook Books

Name/Address Preview/Prints name/address report
Music//CD Preview/Prints Music/CD/Video reports
Medical Records Preview/Prints Medical Records report
Report Explorer Opens up the report explorer allowing you to change standard

Homeventory Reports or design new reports to your needs.

A guide to using Homeventory Using Homeventory - 13



Help Menu

The Help menu contains options for accessing Homeventory Help

The following table briefly describes the Help menu options.

Contents... Displays Homeventory Help
About Displays the Homeventory About Box

14 - Using Homeventory A guide to using Homeventory



Program Toolbar

Id&sSsMl b ate?

Icon Shortcut Meaning
Close Close and quit the program
Inventory Open the Household Inventory database
Vehicle Open the Vehicle Maintenance database
Recipes Open the Recipe (cook book) database
= Coupons Open the coupon organizer
Books Open the Book database
CD/Music Open the CD/Music/VIDEO database
-]
Medical Records Open the Medical Records database
LB
Accounts Open the Accounts database
. Names/ Open the Name/Address database
ﬂﬁ, Address
Report Explorer Open the report explorer allowing you to change standard
Homeventory Reports or design new reports to your needs.
5
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Help

Open the Homeventory user manual in Acrobat

16 -
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Database Navigation Toolbar

H1PP+A5511F~H—r/‘(!i

Icon Shortcut Meaning
“ Next Page Will move forward in the database by 10 records
Next Displays the next record in a table as defined by the record Order and
- Filter.
First Displays the first record in a table as defined by the record Order and
= Filter.
Last Displays the last record in a table as defined by the record Order and
- Filter.
Prior Displays the previous record in a table as defined by the record Order
- and Filter.
Delete Deletes the current record from the table. Relational Integrity is
= enforced.
" Prior Page Will move backwards in the database by 10 records
Post/Save Saves data entered while adding, Copying or editing a record and
v ends the add or Copy.
Add Displays blank form fields for adding a record to a table. If the form is
+ a child in a Related Forms group, the primary key fields in the parent
record are automatically entered into the foreign key fields of the new
child record.
o Refresh Refreshes the current record
- Edit Edits the current record
% Cancel Cancels and edits that have been made
Close Closes the current window and takes you back to the previous
E window.

A guide to using Homeventory
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Setting Options (Preferences)

There are only a couple of options that are required for the proper operation of the software.

“i Preferences g@g|

User Infarmation l System Settings | Custom Fields | Immunizations

Mame: |Sample ser

Address: |1 23 Ay Strest

City/5T /Zip: |Salem, 0OR 97302

Phome; [[907] 5651212

Program Options Screen — User Information

Fields Used on the User Information Tab

Field Contents

Name This is your name as you would like it to appear on your QSL cards

Address 2 lines for address are provided to personalize your QSL cards. The
second line should be used for city, state, and zip code

City/ST?Zip City State and Zip code

Phone Phone Number

18 - Using Homeventory A guide to using Homeventory



% Preferences

User Information,— Skestem Settings ] Custom Fields | Immunizations

B=)E

Last Backup Date: |12/20/2006

Backup Interval; |14

Program Options Screen — System Settings

Field

Last Backup
Date

Fields Used on the Systems Settings Tab
Contents

This is the date of your last backup

Backup
Interval

This is the number of days between backups before you will be notified
that a backup is due

A guide to using Homeventory
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&4 Preferences

Iger Information | System Settings Custom Fields | Immunizations

Field 1: |EERTE

Field 2. |Nat Defined

Field 2. |Mat Defired

Field 4 |Mat Defired

Field & |Mat Defired

Field : |MNot Defined

Field 7. |Mat Defined

Field & |Sampls Option

Program Options Screen — Custom Fields

By using custom fields you and identify on the Inventory screen optional fields that are
specific to your needs. For example you might want a field to record a house identifier if you
have multiple homes.

Fields Used on the Systems Settings Tab

Field Contents
Field 1 Enter the Field name for the Field 1
Field 2 - 8 Additional fields

20 - Using Homeventory A guide to using Homeventory



% Preferences

Usger Information

System Sethings

Custom Fields  Immunizations ]

B

Adenovirus

Anthras

Cholera

Hepatitiz B

Hemophiluz Influenza
Measles Mumps Rubella MMA

Polovinuz Yaccine
Thphoid

Waricela

rellow Feaver

Dipthena Tetanus Pertuzsiz DTP

Program Options Screen — Immunizations

The immunizations tab is a list of any and all immunizations that could be given using the

Medical Records database. This is a quick list so please see the section on medical records

for more information.

A guide to using Homeventory
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Filtering Data

VAN

As you become more familiar with the software and you begin to add more and more records
into the Inventory or Cook Book databases you data files will become quite large and it will
become harder and harder to find information. Suppose you are working on your inventory for
your garage and you are trying to locate your drills. The first step is to pres the Filter (search
light) button to display the following screen for your Household Inventory.

Household Inventory Filter E|
Eields Itern Descriptior

Ireeetary 10 | | Field¥alue s K

Item Description diill Clear

Eg:;dltéorn Search Type x Cancel

Floon% b " Ewact Match

b arwifacturer I

Fodel

Madel Mumber

[ Case Sensitive

Serial Number
Date Purchazed

Place Purchazed b’
Al By Walue
Field Order

(" Alphabetic % Logical Wiew Summary New Search

Household Inventory Filter Screen

The next step it to select “Item Description” on the left hand side of the screen, then enter drill
(you do not need to capiatilize the word). Finally select “partial Match Anywhere”

When you press the OK button you will see a list of only those records that contain the word
“drill”

Finally to return the list to display, press the Filter button again, and press the clear button,
followed by OK.

When using a filter on the date field it must be entered as mm/dd/yyyy

Please remember that when you set a filter the only data you will see is records that match

your criteria. This is also true for reports. If you have a filter set the only records that will be
displayed are those matching that criteria.

Lookup Fields

You will notice that on some of the fields in the edit screens there is a little box to the right of
the field with three dots like the following status field:

22 -
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Status: ||n Usze J |

These fields use lookup tables (described later) for field validation. In plain English you must
have a record in the corresponding table for this field to be valid. The following fields use this
feature:

Broken
In Use
On Loan

Also you will notice the button to the right of the drop-down box. This can be used to
edit entries in the corresponding lookup table

Program Functions

Household Inventory

The Homeventory Browse screen is the first screen that will be displayed when you select
Home Inventory from the Main screen. From this screen you will be able to move up and

down through the data base quickly locating information in your inventory. You may either
use the up and down arrow keys, or the Page Up or Page Down keys or any combination.

You will also notice the record pointer (the little right pointing arrow) on the left hand side of
the screen. This arrow indicates the current record and when you press the EDIT button or
double click on a row, that record will be displayed.
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54 Household Inventory Browse

% i Order

Edit | Filter | Close Inventary ID -

Ireentony 1D | Status Item Description | Condition | Catege ~
1iIn s Book Caze Poor Callec!
2/ InlUse Recliner Fuinat

4 Inlse Pentium Computer System Electr
5| lnUse Lager Jet Printer Electrc
B InUsge Bazeball card collection Collec!
7|lnUse Television Electrc
10/ In Use Cordless Diill Toolz
11| InUse Table Saw Excellant Toolz
14 InUse Hatd amplifer SB-200 Excellent Electrc

Household Inventory Browse Screen

Also on this browse screen, you will find a Record Order field used to help you navigate
through the inventory file:

Order
|In\.fentu:|r_l,l In] ﬂ

Selecting any one of the popup values will change the order in which you are viewing your
inventory file. In the above example Inventory ID is the sort order.

The Edit screen is used for all of the data entry functions including adding, changing (editing),
or deleting records.
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% Home Inventory Edit

M4 W s M o+ = & e

Inventory 1D: ihl

Item: TFable Saw

Categary: |Tools _J

Room: ‘Garage J
Status: |InUse

Condition: ’m

Prifit

| Desc -~
ﬂ Front image

Manufacturer: {Sears J

Model: ‘1 Olnch
Madel No: |GRC10

Serial No: {34787

v

Add | Edit | Delete

Household Inventory Screen (Basic Data)

There are a number of additional tabs used to enter additional information about a single item
(see below)

On the left hand side of the screen you may enter as many photographs of an item as you
wish. For example you might have a front, side and back view. On electronics you may also
have a photo of the serial number.

To use the photo features the following buttons will assist you:

&dd Add a new photograph
Lokdi | Editan existing photo
Delete Delete the currently selected photograph
Pririt Print a single sheet inventory record with corresponding

photographs.

Fields Used on the Basic Information Tab

Contents

Inventory ID this field is the unique number you assign to your item. It is
used to quickly locate and distinguish each item in the
database.
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Item

Used to enter a brief description of the item. Examples:
Computer 1

VCR

Sony Camcorder

Category

The category field is used to group your possessions into logical
groups mostly for sorting purposes. There hare no hard and fast
rules here but please use something you can understand. You must
have a corresponding entry in the Category Lookup table for this
field to be valid. Consider the following examples:

Furniture
Electronics
Computer
Tools
Jewelry

Room

Enter the room where this item is normally kept. You must have a
corresponding entry in the Room Lookup table for this field to be
valid.

Status

The status field can be used to show you information such as
"Sold", "On Loan", or other information you require. You must have
a corresponding entry in the Status Lookup table for this field to be
valid.

Condition

Enter the current condition of this item. You must have a
corresponding entry in the Condition Lookup table for this field to be
valid.

Manufacturer

Enter the name of the manufacturer of the item. If you are unsure,
you could enter "Unknown". You must have a corresponding entry
in the Manufacturer Lookup table for this field to be valid.

Model

Enter a descriptive model term for this item.

Model No

If you know the model number enter, it in this field. If you do not
have a model number you, could enter a descriptive term.

Serial No

If this item has a serial number, enter it here. If it does not have a
serial number, enter N/A. This will show you at a later time you
made an entry for this field.

26 -
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54 Inventory Pictures

Picture Description: 1Fl0nt image

Path: | G:\HomeventonytableSawl jpg

Load Clear oK Cancel

Household Inventory Screen (Photo Selection)

Fields Used on the Inventory Pictures Screen

Field Contents

Description This is a description of the photograph. Examples:
Front View
Back View

Serial Number

Path This is the path on your hard drive where the original photograph was
stored at the time you loaded the photo.

Inventory Pictures Buttons:

Load Use this button to load new images
Clear Use this button to clear out the currently loaded photograph
............. T OK, and accept the changes
Eemes] Cancel all edits
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Bazic Home Information Description | Purchase/Replacement ] Custom Fields ] bainte 4 | ¥

Household Inventory Screen (Description tab)

Fields Used on the Inventory Description Tab

Contents

Text This field can be used to record any additional information you would like
to note. Specific condition of the item, history where it was purchased
and who the prior owners were, etc.
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B asic Home |nformation ] Descriptio

Date Purch: [03/01/1988 v

Custom Fields ] Mainte 4 | *

Place Purch: |Sears J
Inz Palicy: | J
R ’Wl Iv Receipt

wiamanty Exp: ’m‘ [+ Irsured

Quantity: 1

Cost Each:

Total Cost:

[+ Marked/Engraved

Walue Each: 260

Tatal ¥ alue: 250

Appraizer: |

Drate: -

Appr ¥V alue:

Household Inventory Screen (Purchase/Replace tab))

Fields Used on the Inventory Purchase/Replacement T ab

Field Contents

Date Purch Enter the date this item was purchased or try to at least estimate the
year you purchased it.

Place Purch Enter the name of the company or the person where you purchased
this item. You must have a corresponding entry in the Purchased
From Lookup table for this field to be valid.

Ins Policy Enter the insurance policy number. You must have a corresponding
entry in the Accounts table for this field to be valid.

Warranty

Warranty Exp

Receipt Check this box if you have a receipt for this item. Warning: We
suggest you store your receipts in a safe location such as a safety
deposit box.

Insured Check this box if this item is insured as a line item on an insurance
policy.

Marked/Engraved Check this box if this item is either engraved or marked for
identification

Quantity Total number of pieces you have. For example if you have a
collection of coins, create a entry for each unique item and enter the
number you posses here.

Value Each Unit value for a single item.

Cost Each The price you paid for each item.

Total value Enter the total estimated value for this item.

Total Cost Enter the total cost YOU paid for this item.

A guide to using Homeventory
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Appraiser

Date

Appr Value Either enter an actual appraised value or your estimated value for
this item.

Diezcription | Purchaze/Replacement

Sample Option |Yada ‘Yada

Mot Defined |

Not Defined |

Not Defined |

Mot Defined |

Not Defined |

Household Inventory Screen (Custom Fields)

There are 6 text box user fields and 2 checkbox fields that you may design using the
preferences screen to further define what optional fields you will need in addition to the
standard fields. These fields are defined on the Preferences screen.
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Description | Purchaze/Replacement | Customn Fields

I - > i + - - = 1

Date of Maint:  |9/5/2006 -
Cost of Maint: $20.00

‘what waz Done: |Heplaced Belt

who Did Maint: [Sears =

|MaintDate |Eost |W’hat “whao ~
ﬂ 9/5/2008 $20.00 Replaced Belt Sears

Household Inventory Screen (Maintenance)

Fields Used on the Inventory Maintenance Tab

Contents
Date of Maint Date of maintenance event
Cost of Maint Total cost of maintenance including parts and labor
What was done Briefly describe what was done
Who did Maint Select who performed the work
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Vehicle Maintenance

The Vehicle Maintenance Browse screen is the first screen that will be displayed when you
select Vehicle Maintenance from the Main screen. From this screen you will be able to move
up and down through the data base quickly locating your vehicles. You may either use the up
and down arrow keys, or the Page Up or Page Down keys or any combination.

You will also notice the record pointer (the little right pointing arrow) on the left hand side of
the screen. This arrow indicates the current record and when you press the EDIT button that

record will be displayed.

5 Vehicle Information/Maintenance

E
Edit | Close

EBX

Wechicle 1D

Descrption of Yehicle

Model | Date Purch | Fia

f Old Junker
Cherokee

112-3345-SKTF|-'I 12

Vehicle Maintenance Screen (Browse)

Sedan 47211951 L
Cherokee | 4/27/1934 L

|£

32 - Program Functions
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B

&5 Vehicle Edit

4 44

A« = » M + = a W o g

] Yehicle Histary ]

Vehicle ID: [112-3345-5KTR-112

Description: |Ehen:ukee

Model Year: |1334

M ake: |"|EEP todel: |Cherukee
Style: |Larad|:| Bl |1
Ins Policy: 3432212343 ]

Purchase Data

Date: (0452741994

Place: |L|nkn|:|wn

Cost; 24800
] ODE: 5102

Vehicle Maintenance Screen (Basic Data)

Fields Used on the Vehicle Maintenance Screen

Field Contents

Vehicle ID Enter the Vehicle ID (VIN) number found on the vehicle.

Description Enter a general description of the vehicle

Model Year Year the vehicle was manufactured

Make Make/manufacturer of the vehicle

Model Model type or number

Style Style of vehicle, I.E. Coop, station wagon, etc.

Color Color scheme of the vehicle

Ins Policy Enter the insurance policy number this vehicle is covered in. You must
have a corresponding entry in the Accounts table for this field to be valid.

Purch Date Enter the date you purchased this vehicle

Cost Enter the actual amount you paid for the vehicle. Remember, don't forget
to add interest.

Place Enter the name of the company or the person where you purchased this
item. You must have a corresponding entry in the Purchased From
Lookup table for this field to be valid.

ODE
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This screen is used to record the cost of ownership for each vehicle. You may, if you desire,
record all expenses incurred while you own the vehicle, such as gas. There are no rules here,
just what ever suits you.

% Vehicle Edit EI E|E|

S Date: [01/11/2003

Eateg!c:r_u | [Dre=zcription of i.ter.n - ODE- 15700
L Repair replace transmizsion
|| Foutinehd aink il Change Description: |replace o Erieian

Coat: 2600
Categany: |F|epair J
Additional notes or comments:
L

< >

Vehicle Maintenance Screen (Vehicle History)

Fields Used on the Vehicle maintenance History Tab

Field Contents

Date The date you incurred this item
ODE miles?

Description Brief description of this item
Cost Cost including tax
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Category

The category field is used to group your maintenance items into logical
groups mostly for sorting purposes. There hare no hard and fast rules
here but please use something you can understand. You must have a
corresponding entry in the Category Lookup table for this field to be
valid.

Notes

Free form area to record any additional comments or notes about this
specific item.
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Recipes

Back in the mid 70s our forefathers of the computer stated that one of the primary uses of the
home computer was to keep track of recipes. Hundreds of programs have been developed,
some rather complex, to record recipes. Homeventory has taken the simple approach to
record basic recipe information. You can also check our web site from time to time to get
more recipes for your collection.

The Recipe Browse screen is the first screen that will be displayed when you select Recipes
from the Main screen. From this screen you will be able to move up and down through the
data base quickly locating your recipes. You may either use the up and down arrow keys, or
the Page Up or Page Down keys or any combination

You will notice the record pointer (the little right pointing arrow) on the left hand side of the
screen. This arrow indicates the current record and when you press the EDIT button that
record will be displayed.

Recipes (Browse)

E & 9 = B 9 & 2

Close Edit segrch Mark M/Al Reset Import Print

E Close this screen

Close
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Edit the current item highlighted

Search for recipes

Mark current selected record (for printing)

Mark all currently displayed records

Reset (un-mark) all recipe records

Import data in Meal-Master format

Print

To the right of the tool bar there is a quick search box. You may enter any character string
into this box and the only records that will be displayed are those matching the character
string in the category field. For example if you want to print a mini-cook book of Crock-pot
recipes enter Crock-pot into the quick search field, Then press the “Mark All” button, followed
by the print button and the program will only print those selected recipes. When you are done
don't forget to reset the recipes.
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Recipes (Entry/Edit)

Fields Used on the Recipe Entry/Edit Screen

Field Contents

Recipe ID The recipe ID field is used to uniquely identify each of your recipes. This
number will be assigned for you by the software.

Title Enter a brief title for your recipe

Category This subject could be a big debate among the cooking culture. Please

use category to group YOUR recipes into different groups that you can
easily find. For example: "Holiday, Main Dish", "Dessert", etc.

Contributor Where you got this recipe from. I.E. "Mother"

Prep Time There are no formatting rules here. Just enter the time needed to
prepare this recipe.

Yield How much/many this recipe will produce. I.E. "3dz cookies", "12 Ibs.", or
"Serves 12"

Calories Normally this will be number of calories per serving

Fat Normally this will be the fat content per serving

Entering individual ingredients. Enter as many ingredients as the recipe calls for. Information
for using the navigation buttons can be found earlier in this documentation

To add ingredients, press the ADD button and enter information directly into the grid.
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The last step entering a recipe is to record the directions for preparing. The following area on
this screen us used for this purpose:

Used to print the current recipe
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Coupon Organizer

Coupon Organizer Screen

Fields Used on the Coupon Organizer Screen

Field Contents

Coupon Coupon description

Expire Date Expiration date

Manufacturer Manufacturer offering coupon

Quantity Normally this would be the number of items you could purchase on a
single coupon

Value Value of coupon

Store What store, specifically, is offering coupon

Department What department in store. For food coupons you could use this field to

record a category like Frozen Food, Soups, Vegetables, etc.
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Books

Books Screen (Basic Data)

Fields Used on the Books Basic Tab

Field Contents

Title Title of book

Author Author of book

Subject Subject matter of book

Book Type Type of book, Soft, Hard, CD etc.
Category Category

Pages Total number of pages in book
Editor Who edited the book. You may enter multiple names.
Publisher Publisher of book

ISBN Library of Congress ISBN number
Number
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Books Screen (Value Data)

Fields Used on the Books Value Tab

Field Contents

Cost What you paid for this book

Replace What you expect it would cost you to replace this book
Cost

Current Current value. If you need help with this you could use online resources
value such as amazon.com or ebay.com to help you.

Value Date Enter the date when you estimated the current value
Acquired What you purchased this book

From

Date The date you purchased this book

Purchased

Condition The condition of the book

On Loan To If you have loaned this book, enter the name here.
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Books Screen (Abstract)

You may use the Abstract tab to record any additional comments about this book.
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Music/CD/Tapes

The Music/CD/Tapes database contains basic information about your Music collection.

You will also notice the record pointer (the little right pointing arrow) on the left hand side of
the screen. This arrow indicates the current record and when you press the EDIT button or
double click on a row, that record will be displayed.

Music/CD/Tapes Browse Screen
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Music/CD/Tapes Entry/Edit Screen

Fields Used on the Music/CD/Tapes Screen

Field Contents

Album 1D Album ID is a unique identifier you assign to the album
Year The year this work was originally published

Released

Title The title of the Album

Media The media, CD, DVD, Vinyl, etc.

Artist The recording artist

Label The recording label

Genre A Genre to group this music. Examples, Rock, Ballet, etc.
Album Album catalog identification

Catalog

Date Purch Date you purchased this album

Cost Original cost of album

On Loan To If you have loaned album, enter the name here.
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Medical Records

Having good medical records for ALL of your family members could mean a life or death
situation for them. Having this information at your finger tips will benefit everyone.

The Medical Records database is used to collect information that can be helpful when
medical decisions need to be made.

Medical Records Screen (Basic Data)

Use this button to copy the Medical Insurance fields over to the Dental
insurance fields.

Fields Used on the Medical Records Basic Tab

Field Contents
Name Name of family member
Address Family members address
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Phone Family members phone number
SSN Family members Social Security number
M/Status Marital status
DOB Date of birth
Height Height
Weight Weight
Blood Type Blood type
Medical Name
Address
Phone
Group
Policy
Eff Date
Dental Name
Address
Phone
Group
Policy
Eff Date
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Medical Records Screen (Doctors)

Fields Used on the Medical Records Doctors Tab

Field Contents

Name Name of doctor

Kind Kind of Doctor

Address Address

City City

State State

Zip Zip or postal code

Phone Phone number including extension
Notes Any additional notes about this doctor
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Medical Records Screen (Medications)

Fields Used on the Medical Records Medications Tab

Field Contents
Medication Medication type
Type Non-Prescription

Prescription

Supplements
Date Date started medication treatment
Name Medication name
Purpose The purpose of this medication
Dosage Dosage
Cautions Any cautions while using this drug
Pharmacy The pharmacy where this Prescription was filled
Doctor The prescribing doctor
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Medical history is a running log of medical events that have occurred and are noteworthy.
You may choose to enter everything or just highlight significant issues.

Medical Records Screen (Health History)

Fields Used on the Medical Records Health History T ab

Field Contents

Date Date this event occurred

Reason Reason is a brief description of the event
Comments Detailed comments about the event

If the event is an immunization pressing this will display a standard set of
immunizations allowing you to select one and the program will add a medical history record
for you in a standard format. When you press the button the following screen will be
displayed:

Simply select the immunization followed by pressing the OK button and a record will be
created for you.

50 - Program Functions A guide to using Homeventory



Medical Records Screen (Emergency Contacts)

Fields Used on the Medical Records Emergency Contac  ts Tab

Field Contents

Name Name

Address Address

Primary Primary phone number
Phone

Alt Phone Alternate phone number
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Accounts

The Accounts screen is the first screen that will be displayed when you select Accounts from
the Main screen. From this screen you will be able to move up and down through the data
base quickly locating your accounts. You may either use the up and down arrow keys, or the
Page Up or Page Down keys or any combination.

You will also notice the record pointer (the little right pointing arrow) on the left hand side of
the screen. This arrow indicates the current record and when you press the EDIT button that
record will be displayed.

Accounts Screen

Fields Used on the Accounts Screen

Field Contents

Policy No Policy number. You should enter this number exactly as it appears on a
statement or credit card.

Name Enter the name that is on the account, not necessarily your name.

Acct Type Used to categorize accounts. |.E. "Credit Card", "Insurance", "Utility",
etc.

Phone Phone number including area code

Fax Fax number including area code

Email Email address.

Address Address of this company.
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Names and Addresses

It seems that everyone has a computerized address book these days and you ask why? And
we say why not? The Address Book is just another optional feature you may either choose to
use or not. What is unique about ours is the ability to record additional information not found
in others.

The Name and Address Browse screen is the first screen that will be displayed when you
select People (Address) from the Main screen. From this screen you will be able to move up
and down through the data base quickly locating people. You may either use the up and
down arrow keys, or the Page Up or Page Down keys or any combination.

You will notice the record pointer (the little right pointing arrow) on the left hand side of the
screen. This arrow indicates the current record and when you press the EDIT button that
record will be displayed.

Names and Addresses Screen (Basic Tab)

Fields Used on the Name/Address Basic Tab

Contents

First Name First name
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Last Name last name

Nick Name Any other name you use to identify this person
Address 2 lines are provided to enter a complete address
City City

State State

Zip Zip or Postal Code

Country Country

Home Phone Home phone including area code

Work Phone Work phone including area code (aaa) ppp-pppp

Work Ext Work extension

Fax Fax number

Names and Addresses Screen (Additional Data Tab)

Fields Used on the Name/Address Additional data Tab

Field Contents

Email Email Address

Children Children’s name

Hobbies Any hobbies this person might have
Health Issues Any health issues this person might have
Birth Date Birth date

Anniversary Anniversary date
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Holiday Cards tab screen is used to track re-occurring holiday cards. Information for using
the navigation buttons can be found earlier in this documentation

Names and Addresses Screen (Holiday Cards Tab)

Fields Used on the Name/Address Holiday Card Tab

Field
Anniv

Contents

Check this box to indicate to send a anniversary card (You can use the
Report generator to either print a report or print label for people you
want to send anniversary cards to).

Card

Check this box to indicate to send a birthday card (You can use the
Report generator to either print a report or print label for people you
want to send birthday cards to).

Holiday

Check this box to indicate to send a holiday card

Year

If you receive a holiday card from this person, enter the year you
received the card followed by:

Card Sent

Check this box if you sent a card to this person

Card Received

Check this box if you received a card from this person
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Reporting

Report Explorer

The foundation for all reports and labels is based on a technology called the Report Explorer.
(The Report Explorer is covered in a separate manual)

The Report explorer is used to create and make modifications to either reports that you might
have designed or reports that are shipped with the product. If you make changes to the
reports, please use a different name than the standard reports.

Report Explorer Screen

From the Report Explorer you may right click on any report and either print or view the report.

56 - Reporting A guide to using Homeventory



Print Preview Screen Example

Saving Report Specifications to a File

The report manager allows you to save and load your report specifications to and from a flat
file. So if you would like to send us your report specifications you can use this simple

procedure.
1)
2)

3)

4)

Open up the report designer of the report you want to save.

Click on the menu File/Save to File.. and a standard Windows file save
dialog will be displayed

Select the location you would like to save the file to and enter a
descriptive name (Note the dialog will use the RTM as the file extension)

Press the save button and you are done.

Loading Report Specifications from a File

Loading report Specifications is the reverse process as saving.

1)
2)

3)

Open up the report designer of the report you want to load.

Click on the menu File/Load from to File.. and a standard Windows file
open dialog will be displayed

Select the location you would like to load the file from and select the
report file to load (Note the dialog will use the RTM as the file extension)
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4) Press the Open button and your are done.
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Lookup Tables

Category

The Category Lookup table is used to group items into different logical groups mostly for

reporting purposes. There are no hard and fast rules here, just try to develop categories that

make sense to you.

Category Lookup Table Screen

Examples of categories:

Furniture
Electronics
Computer
Tools

Jewelry
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Condition

The Condition Lookup table is used to record the current condition of an item.. There are no
hard and fast rules here, just remember that if you have a loss your insurance will want to
know the condition of an item that is to be replaced

Condition Lookup Table Screen

Examples of Condition:

Excellent
Fair
Good
Mint

Poor
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Room

Make one entry for each room in your house. You might also consider creating rooms for
locations other that your house like: On Loan, Office, etc.

Room Lookup Table Screen

Examples of Rooms:

Living

Kitchen

Den

Bedroom 1
Master Bedroom

Garage
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Status

The status lookup table is used to distinguish a status attribute for the item such as In Use,
On Loan, Sold, Borrowed, etc.

Status Lookup Table Screen

Examples of Status:

In Use
On Loan
Sold
Want
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Manufacturer

Record an entry for each manufacturer you have. Also create a dummy entry for
manufacturers that are unknown.

Manufacturer Lookup Table Screen
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Place of Purchase

Record an entry for each establishment you have purchased goods from. Also create a
dummy entry for places that are unknown.

Place of Purchase Lookup Table Screen
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Warranty

The Warranty lookup table is used to specify the period of a given warranty in the inventory
database.

Warranty Lookup Table Screen
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Backup/Restore

Overview

A separate program is used to perform backup/restore functions. This utility will back up all of
the Homeventory data files.

The backup will backup all of the files into a single file. You may either store these files on
your hard drive or some other external media, floppies, CD, ZIP, etc. The destination can be
set using the Configuration screen.

Backup

After starting up the program you will see the following screen displayed:

Backup Screen
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Restore

Restore Screen

The first step is to select the backup file you would like to restore files from, then check each
file you would like to restore. Pressing the <Select All> button will restore ALL of the files.

Configuration

Configuration Screen

The configuration screen sets the default path/directory where files will be store and also the
reminder interval.
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Data Base Structures

Overview

These table definitions are provided to assist you in using the Report Manager (covered in a
separate manual).
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